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Introduction 1-1
1  Introduction

This Getting Started Guide forms part of the documentation supplied 
with each UniSim Heat Exchanger program:

• UniSim® Heat Exchangers User Guide
• Getting Started
• Program Reference Guide.

The UniSim® Heat Exchangers User Guide is supplied as a pdf 
document with the installation media.  The Documentation media 
contains the UniSim® Heat Exchangers User Guide and all the other 
documents.  The UniSim® Heat Exchangers User Guide is generic to all 
UniSim Heat Exchanger programs.  The Getting Started and Reference 
Guide are specific to each UniSim Heat Exchanger program. 

The Getting Started Guide assumes you have access to an installed 
copy of the UniSim Heat Exchanger program, and takes you through 
some example cases provided with the program, so you can get a feel 
for it capabilities.  It also describes how you can run a set of QA sample 
cases, and compare the output files with sample results, to confirm that 
the operation of the program is as it should be.

More detailed examples, showing how you can use the program to 
solve typical problems, are provided in Appendices to the program 
Reference Guide.

1.1 Technical Support
Technical support is available by phone (1-403-509-1379 or 1-866-
392-8748 toll free in North America), fax (1-403-216-2801).

E-mail support for customers with a current support contract for their 
product is available.

On-line support can be accessed via http://www.honeywell.com/ps.

Honeywell Email Address

Global unisim.support@honeywell.com

North America unisim.support@honeywell.com

Latin America unisim.support.lar@honeywell.com

Europe, Middle East, Africa unisim.support,emea@honeywell.com

Asia Pacific unisim.support.ap@honeywell.com
1-1

mailto:unisim.support@honeywell.com
mailto:unisim.support@honeywell.com
mailto:unisim.support@honeywell.com
http://www.honeywell.com/ps


1-2 Technical Support
When contacting us via email or phone, please include in your 
message:

Your full name, company, phone and fax numbers.

The software version you are using (shown in the Help menu, About 
UniSim…).

A detailed description of the problem (attach a simulation case if 
possible).
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2 Getting Started 

Included with your UniSim® Fired Process Heater Modeler 
(referred to as UniSim® FPH) software are a number of example input 
files that can acquaint you with the program. The cases are fully 
defined and ready to run.  You can simply open the cases and run 
UniSim® FPH to see the type of output that can be calculated.  This 
Getting Started will step you through one of these example cases, as 
a brief introduction to the UniSim® FPH architecture, input options and 
available output information. 

A complete set of results for the sample input files is provided in a 
separate location for Quality Assurance purposes. See Chapter 3 - 
UniSim® QA Examples.

A set of tutorials showing you how to set up input files for (different) 
specific problems is included in Chapter 7 - Examples, of the 
Reference Guide.

Before examining and running the example input files, it is important to 
define the main types of calculations that UniSim® FPH can perform. 
These allow you to calculate the performance of the firebox and/or 
convection sections of a fired process heater.  The examples in the 
Reference Guide will elaborate on this.

The two fundamental UniSim® FPH calculation modes are shown in the 
following table.
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2.1 Example 1
In this first example we will take a brief look at how an existing dataset 
can be reviewed, run and the outputs accessed.

1. Start UniSim® FPH. This can be done several ways and will depend 
on exactly how you set up your desktop. However, the two main 
ways are:
• Clicking the UniSim® FPH shortcut on the Start menu then 

Programs, Honeywell, UniSim® Heat Exchangers Rxxx 
and UniSim FPH menu. See Figure 2.1.

UniSim® FPH Calculation Modes

Fixed 
(Performance 
Simulation)

This is for simulation or design checking.  You 
input information about the firebox geometry, 
the fuel, the combustion air, the convection 
section geometry and the process fluids 
including the inlet condition of the process 
streams and UniSim® FPH calculates the heat 
transfer, temperature and pressure drop 
distributions in the heater and the stream 
outlet conditions.

Calculate 
(Burner Rate 
Mode)

This is a thermal rating option in which 
UniSim® FPH calculates the burner fuel 
flowrate required to achieve a specified heat 
load on the firebox process stream.  You input 
the same information as for the Simulation 
option and in addition specify the outlet 
temperature of the firebox process fluid.  (In 
Rate mode you must also provide an initial 
estimate of the fuel flowrate required for the 
duty).  UniSim® FPH calculates the heat 
transfer, temperature and pressure drop 
distributions in the heater.  UniSim® FPH then 
compares the calculated outlet temperature of 
the process stream in the firebox with that 
specified by you and iterates on the burner 
fuel flow rate until the calculated temperature 
matches the specified temperature.  You can 
only use the Rate mode if you are modelling 
the firebox.
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• Select UniSim FPH from within Windows Explorer.

Once the splash screen has cleared you will see the main UniSim® FPH 
window and over the top of this is the Welcome! dialog. From this view 
you can select to create a New file or an Existing file. If you have used 
UniSim® FPH previously, the project file you have worked with will 
appear in the Recently Used Project File list, making it easy to get 
back to files you were recently working on. 

2. Press the Existing button, to select an Existing file.

3. You are presented with an Open File screen. To open the file for 
this Get Started, go to the 

 Figure 2.1

 Figure 2.2
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2-4 Example 1
C:\Program Files\Honeywell\UniSim Heat Exchangers 

Rxxx\FPH\Samples 

(This is the default directory, the exact location may be different if 
you changed the UniSim® FPH destination directory during 
installation.) See Figure 2.3 for the Open File view.

4. For this example you should select the file QFPH1.FPHI. You will 
know when the file has been loaded, because the Fired Heater 
System diagram will appear within the UniSim® FPH program 
window. See Figure 2.4.

 Figure 2.3

 Figure 2.4
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Once UniSim® FPH has started you can open other files by selecting 
Open from the File menu. To use the Welcome screen again, select 
Start Project from the View menu. However, in either case you can 
only have one project active at any one time. For most common 
activities there are shortcuts. So to open a file you can either click on 
the Open button or use the keyboard shortcut by pressing <CTRL> + 
<O>.      

Now look a bit closer at the project file you have opened. 

1. Click on Input in the menu bar.

Figure 2.5 shows the Input menu, which gives access to all of the 
input data. The menu itself is divided into the different types of data 
you need to describe the fired heater and the conditions under which it 
will operate. These include different aspects of geometry, process 
conditions and physical properties. 

2. Select the Firebox Geometry input form and click on the Firebox 
Tube Layout tab (see Figure 2.6). This view allows the layout, 
tube orientation and arrangement, of the firebox tubes to be set.  

 Figure 2.5

Tip -

If you cannot remember where a file is located, there 
is a Find File utility to help you. Select Find File from 
the File Menu or use the keyboard shortcut by 
pressing <CTRL>+<F>.

Open Button
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2-6 Example 1
This screen is typical of most screens in that the data is entered 
either in a text box, or via a drop-down menu.  The drop-down 
menu presents the list of possible inputs, which you may select. 

3. Now look at process data by selecting Process from the Input 
menu or by clicking on the Process button. See Figure 2.7.    

This shows another form of input screen where the input items are 
arranged in the form of a spreadsheet. If the data do not fit the screen, 
a scrollbar allows you to access the other input items. The spreadsheet 

 Figure 2.6

Note - You may see minor differences in the screens 
in your version of UniSim® FPH, compared with the 
figures in this manual.

Tip -

If at any point you are not sure what input you want 
or something is not clear, you can press <F1> and 
get context sensitive help.  If you select the Tube 
Straight Line Length and press <F1>, you can see a 
description of this parameter.  This help also 
contains links to diagrams and related topics that 
you can use by clicking with the mouse on any of the 
highlighted text.  For example at the bottom of the 
help there is a list of links to diagrams which 
illustrate the concept of tube straight line length as 
used in UniSim® FPH.  Click on the link Straight Line 
Lengths for Vertical Tubes.  A new help page pops up 
showing you how the tube straight line length can be 
defined for vertical tubes.

Process Button
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Getting Started 2-7
view is used when data are required several times, in this case for the 
two streams in the heater.

4. Finally, look briefly at the physical properties input by selecting 
Physical Property Data from the Input menu or by clicking on 
the Physical Properties button. 

The initial screen in Figure 2.8 shows the top level information about 
each stream.

Depending on the type of physical property data you are working with, 
you can either enter the property data for the stream directly or enter 

 Figure 2.7

 Figure 2.8

Physical Properties Button
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data for components and allow UniSim® FPH to perform vapour liquid 
equilibrium and mixture calculations. All of the physical property data 
are managed through these screens.

Since this is an existing case all the necessary data has already been 
entered. 

5. Run UniSim® FPH by doing one of the following:

• Click on the Run button in the Toolbar. 
• Select the Run menu and then Calculate All. 
• Press <F4>. 

UniSim® FPH now displays a status window that reports progress of the 
run.

When the run completes there are three possible outcomes and 
corresponding outputs will be displayed.

• Successful run with no fatal errors and no warnings - a screen 
showing the Results Summary is displayed.

• Successful run with no fatal errors but with one or more 
warnings - the Results Summary is displayed together with the 
Error/Message Log which contains a description of the 
warnings that have occurred.

• Failed run due to fatal errors - the Error/Message Log is 
shown with a description of the errors that have occurred.

In this case you should just see the Results Summary which shows 
you the main process and performance data such as; the Thermal 
Efficiency of the firebox and convection section; the inlet and outlet 
process fluid and gas temperatures to each part of the heater; the inlet 
and outlet process fluid pressure and quality to each part of the heater, 
the tube maximum and minimum temperatures in each part of the 
system and the firebox tube temperature profile allowing for 

Run Button
2-8



Getting Started 2-9
circumferential heat flux (as in API530).  See Figure 2.9.

There are several different outputs that can be viewed from the Output 
menu (see Figure 2.10). 

Notice from this menu the different types of output available.  The 
Brief Output is the same as the Results Summary, and the Error / 
Message Log appears automatically if necessary when a run 
completes. We will look here at the different types of detailed output 
available through the Results option from the Output menu.

UniSim® FPH carries out very detailed calculations on many parts and 
aspects of a fired process heater system and therefore produces a large 
number of results. These results have been carefully categorised to 
give you the maximum choice in the type, content and quantity of the 
output you wish to view and subsequently include.  A hard copy can be 
produced from the Line Printer output. 

 Figure 2.9

 Figure 2.10
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2-10 Example 1
6. Select Full Results from the Output menu. UniSim® FPH 
generates all the necessary output files which contain these results. 
During this process a progress window will appear whilst the results 
are generated. 

After the files have been generated, the main UniSim® FPH Output 
screen will appear. You can use check-boxes on the screen, available 
under the Text tab, to select which sections of the results you wish to 
view, and if necessary, decide on what to include in the Line Printer 
output for printing off. (see Figure 2.11). 

7. Select Graphical Results from the Output menu.

A window will appear detailing the progress made in generating a Line 
Printer file suitable for printing off as a hard copy of your results. On 
completion you will see the file automatically appear in a View Line 
Printer file QFPH1 window. If you look at this file, you will see that it 
contains all the output you have currently selected, in this case the 

 Figure 2.11
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Concise output sheets, from the Output screen. See Figure 2.12. 

We will now look at the graphical output available in UniSim® FPH.

8. Close down the Line Printer screen. 

9. Select Graphical Results from the Output menu. 

The Graph selection screen will appear. See Figure 2.13. 

You may select which graphs and for which part of the heater system you 
want to see the graph cover.  We will look at the temperature pinch chart 
for the Full System.

10.Click on Temperature Pinch Chart and then click the Full 
System button.

A graph showing the process fluid and combustion gas temperature, 
throughout the heater system, will appear. See Figure 2.14.

11.Once you have looked at this graph, you can either print it off, using 
the Print button, or return to the Graph selection screen by 
clicking on the Return button.

 Figure 2.12
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 Figure 2.13

 Figure 2.14
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3 UniSim® QA Examples

A set of two sample UniSim® FPH cases, including both input and 
output files are provided with UniSim® FPH for Quality Assurance (QA) 
purposes. As a check that you have installed UniSim® FPH correctly, 
you should run the input files and compare your results files with those 
provided.

UniSim® FPH files have a file extension .FPHx (where x is an indicator 
of the type of file - input or one of the various outputs). A full listing is 
given in the Help Text.

On installation, the QA files are stored in a subdirectory QADATA of the 
directory containing the main UniSim® FPH folder. The two sample 
cases have file names QFPH1 and QFPH2, and files extensions .QAx 
instead of .FPHx.  The different extensions are used to ensure that you 
don’t accidentally overwrite the QA files when running UniSim® FPH.

Copies of the two QA input files, with the standard input file extension 
.FPHI are put in the My Documents\My UniSim Heat Exchanger 
Cases directory by the installation procedure.

3.1 Creating Output for 
Comparison

Using the QFPH1 example, a typical check on UniSim® FPH installation 
would be as follows:

1. Copy the QFPH1.QAI file from the \UniSim FPH\QADATA 
directory to some other directory for example \My 
Documents\My UniSim Heat Exchanger Cases.

2. Rename the file, and give it the extension .FPHI for example 
MYTEST1.FPHI.

3. Start UniSim® FPH, you will see the Welcome screen, click on 
Existing and select MYTEST1.FPHI 

4. Run UniSim® FPH with this case.

5. Compare the results files from your run with the results files 
supplied with UniSim® FPH.

6. Checks may be repeated with the other QA files supplied.
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3.2 Comparing Outputs
Your calculated results are files named MYTEST1.FPHx, in directory 
\My Documents\My UniSim Heat Exchanger Cases and these 
need to be compared with the supplied results files QFPH1.QAx in 
directory \UniSim FPH\QADATA.  

The most important comparison is the .FHV file, but other files can be 
compared as well. The .FHV file is the Results Summary and is a 
relatively short file. You can do the comparison using a file difference 
utility, or by printing off the two files and looking for differences.

If the files are exactly identical, (except for the run time and input file 
name recorded in the output), the QA check is successful. If the files 
differ slightly, but only in the fourth or fifth significant figure of one or 
two variables, the QA check on this example is also successful. If there 
are more significant differences, consult Honeywell.

 Figure 3.1

Remember, the QADATA 
files supplied with 
UniSim® FPH have the 
extension .QAx.
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